Contents

1 iSupplier Portal Basics .................................................................................................................. 1
  1.1 Logging onto iSupplier Portal for the First Time .................................................................. 1

2 Supplier Administration .............................................................................................................. 4
  2.1 Adding a Company Address ............................................................................................... 4
  2.2 Adding a Company Bank Account .................................................................................... 7
  2.3 Adding a VAT Registration Number .................................................................................. 10
  2.4 Amending Existing Supplier Records – Change of Address ............................................ 11
  2.5 Amending Existing Supplier Records – Change of Bank Details ...................................... 13
  2.6 User Administration ........................................................................................................ 17
  2.7 Creating a New iSupplier Logon ....................................................................................... 17

3 Purchase Orders ......................................................................................................................... 19
  3.1 Viewing Receipts ............................................................................................................... 19
  3.2 Viewing and Managing Purchase Orders ........................................................................... 20

4 Managing Invoices .................................................................................................................... 24
  4.1 Create an Invoice .............................................................................................................. 24
  4.2 Submitting Saved Invoices ............................................................................................. 31
  4.3 View Submitted Invoices ................................................................................................. 31

5 Credit Notes ............................................................................................................................. 34
  5.1 Create a Credit Note ......................................................................................................... 34

6 Appendix 1 - Updating a Company Contact .......................................................................... 39

7 Appendix 2 - Changing your Email Preferences ...................................................................... 40

8 Appendix 3 - iSupplier Worklist ............................................................................................. 41

9 Appendix 4 - Managing your Pop-Ups .................................................................................... 44
  9.1 Google Chrome ............................................................................................................... 44
    9.1.1 Allow all pop-ups ................................................................................................... 44
    9.1.2 Manage pop-ups for a specific site ......................................................................... 44
  9.2 Internet Explorer .............................................................................................................. 45
    Turn Pop-up Blocker on or off ......................................................................................... 45
Legend

**Action Note:**
This is to draw your attention to an action you **MUST** take in order to successfully use the iSupplier system.

**Learning Note:**
This is to draw your attention to useful additional information that you may find interesting.

**Caution Note:**
This is to give you forewarning about an action that is **NOT** advisable or may have consequences that could impact on your effective use of the system.
1 iSupplier Portal Basics
This section aims to help you logon and navigate around the iSupplier Portal pages.

**Learning Note:**
Wildcards are rarely required but when they are it is % in the iSupplier Portal, for example %omp% will return results such as computer, compete, complete, etc.

**Caution Note:**
Do not use browser buttons like back or forward. The iSupplier website is secure and, occasionally, it will timeout when the browser buttons such as back and forward are used to protect your data.

**Action Note:**
Fields marked with * are mandatory and data must be entered before proceeding.

**Action Note:**
Use Quick Select to save time. iSupplier provides a quick select button next to every search result.

**Action Note:**
To change responsibility, for example from RCUK iSupplier Portal Supplier Admin to RCUK iSupplier Portal Supplier User, select the Home link.

1.1 Logging onto iSupplier Portal for the First Time
Once you have been registered with UK SBS you will receive an email containing a link to the iSupplier Portal along with your username and password. The password supplied is temporary and you will be prompted to set a new password when you logon for the first time.

The iSupplier Portal is a secure website and it is suggested that you use the Logout link in the top right hand corner before you leave the website.

**Action Note:**
If you experience access issues, for example you do not receive the invite please make sure you check your spam folder and ensure your Pop-up Blocker is disabled.
Learning Note:

If you need to change or reset your password this must be done on the iSupplier Portal website by clicking on Login Assistance.

Once you have requested to reset your password you will receive an email from UK SBS with further instructions.

Please wait at least 15-30 minutes for the email to come through and ensure it hasn't been moved to your Spam folder before contacting UK SBS.

If you need to contact UK SBS, please email finance@uksbs.co.uk or call 01793 867004.

1. Login using the username and password provided in your email.
2. Click in the User Name field and enter your logon details.
3. Enter the Password.
4. Click the Login button.
5. You will be asked to change your password the first time you logon.
6. Reset your password and click the Submit button.
7. The Oracle Home Page will be displayed.
8. Your Navigator will list all the "responsibilities" you have access to.
9. Click the RCUK iSupplier Portal Supplier User link to view your Home page.

10. Notifications will display the last 5 unread messages from the iSupplier Portal.

**Learning Note:**

If you have Supplier Admin access you can use the **Home** link to switch between Admin and User responsibilities.
2 Supplier Administration

If you are a new supplier you will be required to enter your own company information. The following information must be checked or entered for you to receive Purchase Orders and Payments from UK SBS:

- Check the company address, telephone number and email address we entered on your behalf
- Enter your company bank account
- A VAT Registration Number (if you are VAT Registered)

**Action Note:**
Please ensure you add your company address BEFORE adding your bank details.

**Learning Note:**
Other existing supplier information can be updated at any time by simply clicking on the icon. This icon appears next to existing information; e.g. addresses or bank accounts.

2.1 Adding a Company Address

All newly registered companies must enter their purchasing and payment addresses into the iSupplier Portal. No purchase orders can be created without an address set for purchasing and no payments can be made if no address is set for payment. If you have more than one purchasing address then these can all be added. However, please be aware that our users will see all your purchasing addresses and they may not know which one to select unless they're ordering from a catalogue.

**Caution Note:**
You must add an email and telephone number to your address.

1. Click the RCUK iSupplier Portal Supplier Admin link.
2. Click the **Address Book** link.

3. Click the **Create** button.

---

**Action Note:**

If you are entering a UK address please use your post code as your **Address Name**, for example **SN6 2NA**.

If you are entering a foreign address please use your post code followed by the currency you will be billing UK SBS, for example **CH-4077 – USD**.
Caution Note:
Each address must have a unique Address Name and cannot be duplicated.

4. Enter the required information into the Address Name field.

5. Select the appropriate Country from the drop down list.

6. Enter the required information into the following fields:
   - Address Line 1.
   - City/Town.
   - County.
   - Postal Code.
   - Phone Area Code.
   - Phone Number.
   - Email Address.

Action Note:
In the Note field state whether you would like to receive your purchase orders and remittances by email, fax or post. If you select email or fax please ensure that you have entered the details above.

Learning Note:
Please note that the preferred UK SBS communication method is email.

7. Click the Save button.

8. Your address has been successfully added to your Address Book.
2.2 Adding a Company Bank Account

All newly registered companies must enter their bank details on iSupplier before they can be paid. All new bank accounts will be quickly reviewed and approved by a member of the UK SBS Supplier Maintenance Team.

**Caution Note:**

**UK Suppliers:** Entering the correct bank details is your responsibility and UK SBS cannot be held liable if this information is incorrect.

**Action Note:**

**Non UK Suppliers:** UK SBS will enter the bank details on the suppliers behalf. Please complete the attached form [Supplier Creation Form](#).

1. Click the **RCUK iSupplier Portal Supplier Admin** link.
2. Click the **Banking Details** link.
3. Click the **Create** button.
4. From the **Country** drop down menu, select **More**.
5. Enter the country, for example **United Kingdom** and click **Go**.
6. Click the **button.**
Action Note:
If you will not be receiving foreign payments from UK SBS into this bank account from us, please un-tick Account is used for foreign payments.

7. Ensure Existing Branch is selected.

8. Click the Magnifying glass next to Branch Name.

Search and Select: Branch Name

Search

To find your item, select a filter item in the pulldown list and enter a value in the text field, then select the "Go" button.

Search By Branch Name Go

Results

<table>
<thead>
<tr>
<th>Select</th>
<th>Quick Select</th>
<th>Branch Name</th>
<th>Branch Number</th>
<th>Bank Name</th>
<th>Bank Number</th>
<th>BIC</th>
<th>Branch Type</th>
</tr>
</thead>
</table>
| No search conducted.

9. Select Branch Number from the Search By drop down list.

10. Enter your 6 digit sortcode, for example %123456% and click Go

11. Click the button next to the relevant option.
Caution Note:
If the bank details you require do not appear, return to the previous screen and search for the Bank Name, for example %Natwest% ensuring Existing Bank is selected and press TAB on your keyboard. Then select New Branch and enter the details manually.

12. Enter the required information into the following fields:
   - Account Number (for UK accounts this should be 8 digits).
   - Account Name.

13. To select your Currency, click More from the drop down list.

14. Enter the Country Code, for example if you are billing UK SBS in Pounds Sterling enter GBP.

15. Click Go.

16. Click the button next to the relevant option.

17. Enter a Note to Buyer.

18. Click the button.

Learning Note:
If you have more than one bank account you can Increase or Decrease the priority of your bank account using these buttons.

19. Click the button.

20. Your bank account has now been saved.

Caution Note:
Invoices cannot be created until UK SBS have approved your bank details. You will be notified once approved/rejected.
2.3 Adding a VAT Registration Number

If you are registered for VAT you must add your VAT number onto iSupplier. VAT Numbers and other company details can be found under the Organization link.

1. Click the Organization link.

![Organization screen](image)

2. Enter your VAT number in the Tax Registration Num field.

3. Click the Save button.

4. Your VAT number has been saved.
2.4 Amending Existing Supplier Records – Change of Address

To register a change of address, please ensure you create a new record rather than overtyping the existing data.

Caution Note:
SMARTFORM, SWAREHOUSEONLY and GRANT sites should never be Removed, simply use the Update icon and amend the address as appropriate.

1. Click the RCUK iSupplier Portal Supplier Admin link.

2. Click the Address Book link.

3. Click the Create button.

Action Note:
If you are entering a UK address please use your post code as your Address Name, for example SN6 2NA.

If you are entering a foreign address please use your post code followed by the currency you will be billing UK SBS, for example CH-4077 – USD.

Caution Note:
Each address must have a unique Address Name and cannot be duplicated.
4. Enter the required information into the **Address Name** field.

5. Select the appropriate **Country** from the drop down list.

6. Enter the required information into the following fields:
   - Address Line 1.
   - City/Town.
   - County.
   - Postal Code.
   - Phone Area Code.
   - Phone Number.
   - Email Address.

   **Action Note:**
   In the **Note** field state whether you would like to receive your purchase orders and remittances by email, fax or post. If you select email or fax please ensure that you have entered the details above.

   **Learning Note:**
   Please note that the preferred UK SBS communication method is **email**.

7. Click the **Save** button.

8. Your address has been successfully added to your Address Book.

9. To remove the old address, select 🗑
10. A warning message will appear:

![Warning Message]

**Warning**
The address SW1H 0TH has been inactivated. All of the sites associated with the address have also been inactivated and the address is no longer associated to any contacts or bank accounts.

Would you like to proceed with this action?

11. Select **Yes**

**Learning Note:**
The old address has now been removed.

---

### 2.5 Amending Existing Supplier Records – Change of Bank Details

To register a change of bank details, please ensure you create a new record rather than overtyping the existing data.

**Caution Note:**
Entering the correct bank details is your responsibility and UK SBS cannot be held liable if this information is incorrect.
Action Note:

**Non UK Suppliers:** UK SBS will enter the bank details on the supplier's behalf. Please complete the attached form [Supplier Creation Form](#).

1. Click the RCUK iSupplier Portal Supplier Admin link.
2. Click the **Banking Details** link.
3. Click the **Create** button.
4. From the **Country** drop down menu, select **More**.
5. Enter the country, for example **United Kingdom** and click **Go**.
6. Click the **** button.

Action Note:

If you will not be receiving foreign payments into this bank account from UK SBS, please un-tick **Account is used for foreign payments**.

7. Ensure **Existing Branch** is selected.
8. Click the Magnifying glass next to **Branch Name**.
9. Select Branch Number from the Search By drop down list.

10. Enter your 6 digit sortcode, for example %123456% and click Go.

**Caution Note:**
If the bank details you require do not appear, return to the previous screen and search for the Bank Name, for example Natwest% ensuring Existing Bank is selected and press TAB on your keyboard. Then select New Branch and enter the details manually.

11. Enter the required information into the following fields:
   - Account Number (for UK accounts this should be 8 digits)
   - Account Name.

12. To select your Currency, click More from the drop down list.

13. Enter the Country Code, for example if you are billing UK SBS in Pounds Sterling, enter GBP.

14. Click Go

15. Click the button next to the relevant option.

16. Enter a Note to Buyer.

17. Click the button.
18. Your bank account has now been saved.

19. Enter the End Date of the bank details no longer valid by selecting button.

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Priority</th>
<th>Increase Priority</th>
<th>Decrease Priority</th>
<th>Status</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>02-Jul-2014</td>
<td>03-Jul-2014</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03-Jul-2014</td>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td>Approved</td>
<td></td>
</tr>
</tbody>
</table>

20. Decrease the priority of the old details to ensure the new set are marked as Priority 1.

21. Click the button.

Caution Note:
UK SBS will review these details before any invoices or payments will be made to this account. You will be notified when this review is complete.
2.6 User Administration

You are responsible for the setup and management of new users who can access the iSupplier Portal within your company. The iSupplier Portal allows you to:

- Create Company Contacts with iSupplier Portal Logons
- Specify whether or not iSupplier Portal users can access the Supplier Admin and the Supplier User screens
- Reset user passwords
- Remove iSupplier users

2.7 Creating a New iSupplier Logon

If you are an iSupplier Administrator you can create iSupplier logons for designated individuals within your company and specify the type of access that the new users can have.

Within UK SBS we provide the following access for users:

- RCUK iSupplier Portal Supplier Admin

  This "responsibility" allows users to update company information such as addresses and bank details. Any user with this responsibility will also be able to create new iSupplier users.

- RCUK iSupplier Portal Supplier User

  This "responsibility" allows users to view and manage purchase orders and invoices.

  **Action Note:**
  It is the Administrators responsibility to de-activate accounts no longer in use.

1. Click the RCUK iSupplier Portal Supplier Admin link.
2. Click the Contact Directory link.
3. Click the Create button.
4. You may notice that only the First and Last Name fields, along with Email Address are mandatory but please enter as much detail as possible for your contact.

  **Caution Note:**
  To create a User account a valid email address must be entered.
5. Enter the required information into the following fields:
   - First Name.
   - Last Name.
   - Email Address.

6. To create an account, tick the Create User Account for this Contact box.

7. Click the **Apply** button.

**Learning Note:**

Your contact has been successfully created. They will soon receive an email from UK SBS with a link to the iSupplier Portal and their username and password.

**Action Note:**

Please ensure you advice your colleague where to find the Reference Guide they will need in order to use the system.
3 Purchase Orders

3.1 Viewing Receipts

UK SBS use a 3-way match process. This means that before any invoices are paid the amount/quantity on the invoice must match the amount/quantity on both the purchase order and the receipt.

Invoices will be placed on hold if:

- No receipt has been entered
- The amount/quantity on the invoice exceeds the amount/quantity on the purchase order and/or receipt.

1. Click the RCUK iSupplier Portal Supplier User link.

2. Click the Receipts link.

3. To view all receipts click the Go button.

4. All existing receipts will be shown. If an Invoice has already been created the number will be shown here.

5. If you have more than 10 receipts click on Next 10 to view the next 10 receipts.

Learning Note:
To extract your search results into a spreadsheet click on Export.

6. Selecting the PO Number will give you a quick summary on how much has been receipted.

7. Once an invoice is created you can also see the Invoiced Amount and the Payment Status.
3.2 Viewing and Managing Purchase Orders

The iSupplier Portal allows you to view and download Purchase Orders.

Purchase Orders raised by UK SBS maybe for any one of its associated Research Councils or Organisations. The Organisation or Research Council will always be listed on the PDF Purchase Order and will be labelled as the Operating Unit in the iSupplier Portal.

Our current list of associated Organisations includes:

- **AHRC** - Arts & Humanities Research Council
- **BBSRC** - Biotechnology and Biological Sciences Research Council
- **ESRC** - Economic and Social Research Council
- **EPSRC** - Engineering and Physical Sciences Research Council
- **MRC** - Medical Research Council
- **NERC** - Natural Environment Research Council (and its subsidiaries such as British Antarctic Survey and British Geological Survey)
- **STFC** - Science & Technology Facilities Council
- **CLIK** - Science & Technology Facilities Council Innovation
- **SSC** – UK SBS
- **IAH (Pirbright)** - Institute for Animal Health

**Caution Note:**

All Purchase Orders within iSupplier Portal will be displayed with their net value.

**Learning Note:**

Each time a purchase order is raised, amended or cancelled you will receive an email to notify you of our requirements.

You do not need to acknowledge these orders but be aware that another copy will always be sent to the email address, fax number or postal address that was specified when your purchasing address was set up.

**Caution Note:**

Amended Purchase Orders will have a Revision suffix, e.g. 40800001234, 1, and will be marked as a revision. Please treat this as an amendment to an existing order and not a new purchase order.
Action Note:
To amend existing purchase orders for items such as:

- Delivery Date
- Quantity
- Price Changes

Please contact UK SBS finance on 01793 867005 or alternatively email procurement@uksbs.co.uk

1. From the notification, click the SSC - Operating Unit - Standard Purchase Order XXXXXXXXX, 0 link.

2. You can download all the Purchase Order information under References.
   - The PDF Document is the Purchase Order.
   - The Zip Attachment contains all additional attachments relating to the order.

3. To mark the notification as read, click the OK button.

4. This will remove the notification from your iSupplier Portal Home Page.

5. Click the Home tab.

6. The last 5 Purchase Orders will be displayed under Orders at a Glance.

7. To view or filter the full list of Purchase Orders click the Full List button under Orders at a Glance.

8. The last 25 Purchase Orders can be seen on this screen. If there are more than 25 orders you will have an option to view your Next 25 orders.

9. Alternatively you can use Advanced Search to find specific orders.

10. The specified Operating Unit is the company that created the order.

Learning Note:
Regardless of the Operating Unit, UK SBS will remain the main point of contact for purchase order and Invoice queries.

11. To view the details and attachments click on the PO Number.

12. The most important details of the Purchase Order can be seen on the PDF Document.

13. Select View PDF from the Action drop down list.
14. Click the **Go** button.

15. Click the **Open** button.

16. The full details of order can be seen here, this includes any message from the requestor to the supplier (marked in red).
17. Click the button.

18. Further details and attachments can be seen at the bottom of this screen.

**Learning Note:**

Attachments are visible if the icon is displayed.

19. Select the Title to open the attachment.

20. Click the link (if applicable).

21. Click the button.
4 Managing Invoices
The iSupplier Portal will allow you to track your invoices and payments.

Caution Note:
For multiple invoice upload there is a spreadsheet document available on the UK SBS website iSupplier. Guidance on how to complete the template can be found on page 48. Once completed the form should be submitted to finance@uksbs.co.uk stating More4apps in the subject heading ensuring you attach copies of the related invoices.

Learning Note:
Grant invoices are not required to go through iSupplier. Grant invoices should be submitted to finance@uksbs.co.uk but they must clearly state “Grant”.

4.1 Create an Invoice
You are able to create invoices for any purchase orders displayed in iSupplier Portal.

1. Click the RCUK iSupplier Portal Supplier User link

2. Click the Finance tab.

3. Click the button next to Create Invoice.
Action Note:
Pop-ups are required when using iSupplier in order to search for your supplier information. Pop-ups are a setting on your PC. Please liaise with your IT contact if required or see Section 9 – Appendix 4.

Action Note:
An operating unit must be entered; this is the Research Council you are billing, for example prefix the default search criteria %Operating%Unit with the relevant council, for example ESRC%Operating%Unit or alternatively select button and choose as appropriate.

- AHRC - Arts & Humanities Research Council
- BBSRC - Biotechnology and Biological Sciences Research Council
- ESRC - Economic and Social Research Council
- EPSRC - Engineering and Physical Sciences Research Council
- MRC - Medical Research Council
- NERC - Natural Environment Research Council (and its subsidiaries such as British Antarctic Survey and British Geological Survey)
- STFC - Science & Technology Facilities Council
- CLIK - Science & Technology Facilities Council Innovation
- SSC – UK SBS
- IAH (Pirbright) - Institute for Animal Health

4. Enter the required information into the Purchase Order Number From field.

5. If you are searching for a single Purchase Order please enter the number again in Purchase Order Number To field.
Caution Note:
Do not enter additional information in the remaining fields as this can impact the search results.

6. Click the **Go** button.

7. All the lines that have been placed on the Purchase Order can be seen here.

Learning Note:
You can see the Ordered, Received and Invoiced amounts here. If your total invoiced amount matches, or is less than the receipt amount then your invoice will not be placed on hold.
8. Select ✔ all the lines to be invoiced. If there is more than one line, select as appropriate.

9. Click the **Add to Invoice** button.

10. Click the **Next** button.

**Learning Note:**
The iSupplier Portal will only give you an option of selecting a physical address, however, the remittance advice will be sent via your preferred communication method specified against this address (e.g. email, fax or post).

11. If you have more than one address registered on iSupplier, you will need to select the appropriate address for the invoice raised. Select the **Remit To** button and click **Go**. Click ✔ next to the relevant option.

12. Select the **Remit To Bank Account** to choose the bank account.

13. Click the **Go** button.
14. Click the button next to the relevant account.

**Caution Note:**
UK SBS cannot be held liable for incorrect bank details on Invoices.

**Action Note:**
If the search generates no results, ensure you have entered bank details (see section 2.2) failing that please contact finance@uksbs.co.uk or 01793 867004 as the information may be awaiting approval by the Database Management Team.

15. Enter the required information into the Invoice Number field.

16. To amend the invoice date, click and select as appropriate.

17. An Invoice Description must be entered.

**Action Note:**
Foreign Suppliers must attach a PDF copy of the invoice for VAT purposes. Click the button, then and locate the document on your computer.

18. Ensure that the Customer Tax Payer ID has auto-populated. If the field is not populated click the and click Go. Select the option that appears. The Customer Tax Payer ID relates to the Research Council not your company.

19. If the full Quantity has not been supplied, please overtype the Quantity with the net amount you are invoicing for.

**Caution Note:**
If there are insufficient funds on the Purchase Order you must contact procurement@uksbs.co.uk who will route you through to the relevant procurement contact.

20. Click the button.

21. The bottom right-hand corner on Step 3 shows the invoice breakdown this must match your own invoice before proceeding.
22. If required the VAT can be amended under Summary Tax Lines. If no amendment is required jump to step 26.

**Learning Note:**

**Multiple Tax Rates** - If the PO has been created for £200 at 20% VAT the current Tax Amount will show £40.00. To bill for multiple tax rates, i.e. £100 + VAT and £100 at Zero rated, overtype the Tax Amount to show £20.00 and jump to step 25.

23. If you change your VAT rate please select one of the following options if you're a UK Supplier:

- Standard
- Reduced
- Exempt
- Zero
- Out of Scope
Caution Note:
Foreign currency invoices are usually “Out of Scope” for Tax purposes, unless the Tax has been reverse charged in which case EU or Non EU Standard would apply.

24. The Tax Status Code and Tax Rate Code should both be updated to reflect the VAT you are charging.

25. Once amended click Calculate followed by the Recalculate Total button followed by the Calculate button again.

Caution Note:
Check the invoice breakdown before proceeding. The NET, VAT and total should all match your invoice.

26. Click the Next button to review the invoice before submitting.

Learning Note:
If you do not want to submit the invoice until a later date, select Save. See section 4.2 on Submitting Saved Invoices.

27. Once you have reviewed the invoice, click Submit.

28. Your invoice has successfully been submitted and the status can be viewed under Search on the page.

Learning Note:
If for any reason an un-paid invoice needs to be cancelled please contact finance@uksbs.co.uk or alternatively ring the helpdesk on 01793 867004.
### 4.2 Submitting Saved Invoices

You are able to save invoices to submit at a later date.

1. Click the **Finance** tab.
2. Change the Invoice Status to Unsubmitted.
3. Click the **Go** button.
4. Use the Update ✍️ button to open the relevant invoice.
5. Complete the invoice and click **Submit**.

### 4.3 View Submitted Invoices

The iSupplier Portal allows you to track your Invoices and their payment statuses.

1. Click the RCUK iSupplier Portal Supplier User link
2. Click the **Invoices** link.
3. You can search for either a specific invoice or alternatively use the Advanced Search button for further options.
4. Click the **Go** button.
5. Your Invoices can be viewed by clicking on the **blue** Invoice number.

**Learning Note:**
Details such as invoice holds or whether an invoice has been paid can be viewed here. The data can also be extracted by clicking on **Export**.
Learning Note:
The **Scheduled Payments** tab includes information such as the **Due Date, Status** and payment **Method**.

---

Learning Note:
The **Hold Reasons** tab includes information such as any **Hold Names** applied to your invoice along with the **Hold Reason**.

---

6. Selecting the **Return to View Invoices** link will return you to the previous search screen.

Learning Note:
To search for all invoices either on hold, approved, cancelled, in-process or rejected amend the **Invoice Status**.
5 Credit Notes
The iSupplier Portal will allow you to track your invoices, credit notes and payments.

5.1 Create a Credit Note
Credit notes should only be processed if the Invoice it relates to, is already entered on Oracle.

Caution Note:
Credit notes should be entered against the purchase order line the original invoice was matched to. If that line has been fully used and therefore does not appear at step 1 please contact procurement@uksbs.co.uk to re-open the line.

Caution Note:
Credit notes should be entered using the same supplier site as the original invoice, unless the site is no longer active and therefore you should use the new site.

1. Click the RCUK iSupplier Portal Supplier User link
2. Click the Finance tab.
3. Click the Go button next to Create Invoice.

Action Note:
An operating unit must be entered; this is the Research Council you are billing, for example prefix the search criteria SSC%Operating%Unit, or alternatively select button and choose as appropriate.

A list of Research Councils can be found on page 20.

4. Enter the required information into the Purchase Order Number From field.
5. If you are searching for a single purchase order, please enter the number again in Purchase Order Number To.
6. Click the **Go** button.

7. Select all the lines associated with the credit. If there is more than one line, select as appropriate.

8. Click the **Add to Invoice** button.

9. Click the **Next** button.

**Learning Note:**

The iSupplier Portal will only give you an option of selecting a physical address, however, the remittance advice will be sent via your preferred communication method specified against this address (e.g. email, fax or post).

10. If you have more than one address registered on iSupplier, you will need to select the appropriate address for the invoice raised. Select the **Remit To** button and click **Go**. Click **»** next to the relevant option.

11. Select the **Remit To Bank Account** to choose the bank account.
12. Click the Go button.

13. Click the button next to the relevant account.

Caution Note:
UK SBS cannot be held liable for incorrect bank details associated with an iSupplier record.

14. Enter the credit note number into the Invoice Number field.

15. To amend the invoice date, click and select as appropriate.

16. Change the Invoice Type using the drop down menu to Credit Memo.

Action Note:
Enter a description in the Invoice Description field including the invoice number the credit relates to.

17. Ensure that the Customer Tax Payer ID has auto-populated. If the field is not populated click the and click Go. Select the option that appears. The Customer Tax Payer ID relates to the Research Council not your company.

18. Amend the Quantity if necessary depending on the credit value.

Learning Note:
Credit amounts must be shown as a minus amount (-).

19. Click the Next button.

20. The bottom right-hand corner on Step 3 shows the credit breakdown this must match your own credit before proceeding.

21. If required the VAT can be amended under Summary Tax Lines. If no amendment is required jump to step 25.
22. If you change your VAT rate please select one of the following options if you're a UK Supplier:

- Standard
- Reduced
- Exempt
- Zero
- Out of Scope

**Caution Note:**
Foreign currency invoices are usually “Out of Scope” for Tax purposes, unless the Tax has been reverse charged in which case EU or Non EU Standard would apply.

23. The **Tax Status Code** and **Tax Rate Code** should both be updated to reflect the VAT you are charging.

24. Once amended click **Calculate** followed by the **Recalculate Total** button, followed by the **Calculate** button again.

25. Click the **Next** button to review the credit before submitting.

**Learning Note:**
If you do not want to submit the credit note until a later date, select **Save**. See section 4.2 on Submitting Saved Invoices.
26. Once you have reviewed the credit, click Submit.

27. Your credit memo has successfully been submitted and the status can be viewed under Search on the finance page.

Learning Note:
If for any reason you wish to cancel the credit note, please contact finance@uksbs.co.uk or alternatively ring the helpdesk on 01793 867004.
6 Appendix 1 - Updating a Company Contact

Company contacts can be updated at any time, for example name or telephone number changes.

1. Click the RCUK iSupplier Portal Supplier Admin link.
2. Click the Directory link.
3. Click the Update button next to the relevant record.
4. Amend details.
5. Click the Apply button.
6. Your company contact has now been updated.
7 Appendix 2 - Changing your Email Preferences

iSupplier will send you an email for every notification you receive. If you find that you are receiving too many emails, you can change your preferences to either receive a daily summary email or no emails at all.

1. Click the Preferences link.

2. Click the Email Style drop-down list and select the relevant style:
   - HTML mail with attachments - is the default email setting which will email you each time you receive a notification.
   - HTML summary mail - will email you once a day with a summary of all your notifications.

   **Caution Note:**
   Please do not use Disabled.

3. Click the Apply button.

4. You have successfully updated your Email Preferences.
8 Appendix 3 - iSupplier Worklist

Your Worklist displays all important messages from UK SBS and its associated Research Councils and Organisations. It is important to manage these messages, called notifications, and to either mark them as read or actioned when they have been dealt with.

Learning Note:
Your Worklist can be seen on your Home Page where it will show the last 5 unread notifications.

To view all your notifications, click on the Full List button.

To mark your notifications as read, open the message and either click on OK or an action button such as Approve. All read notifications will disappear from your Worklist but you can still view them by clicking on Full List and selecting the All Notifications view.

You will receive two types of notifications:

- **For Your Information (FYI) Notifications** - These notifications are for information purposes only. You must click on OK before these notifications are marked as read.

- **To Do Notifications** - These notifications require an action (e.g. Approval). You must action these notifications before they are marked as read.

Notifications you will receive include the following:

- New Purchase Orders (FYI Notification)
- Approved Purchase Order Changes (FYI Notification)
- Rejected Purchase Order Changes (FYI Notification)
1. You will see your last 5 unread messages under **Notifications**.

2. To open a notification, select it from the list.

3. Review the notification and click the button to mark the message as read.

**Learning Note:**

Notifications may include attachments depending on the type of notification. These can be viewed by clicking the link within the **References** section.
4. The notification has now been removed from your unread notifications list.

5. To view all notifications click the Full List button.

6. This screen will display 25 notifications at a time. If there are more than 25 a Next 25 link will become available.

![Learning Note:]
Multiple notifications can be read or closed at the same time, click the Select All link.

7. Click the Open button to read or action all selected notifications.

8. All the read notifications have now disappeared from your view.

9. To view read/closed notifications click the View drop-down list and select All Notifications.

10. You can view the following groups of notifications:

   • All Notifications
     - Displays all notifications, including closed notifications

   • FYI Notifications
     - For Your Information notifications that have not been marked as read

   • Notifications From Me
     - Notifications that you have sent, for example to UK SBS when you add a company address or bank account.

   • To Do Notifications
     - Notifications that require an action or response. These notifications cannot be closed without the required action or response.

11. Click the Go button.

12. All Open, Closed and Cancelled notifications can be seen here.
9 Appendix 4 - Managing your Pop-Ups

Action Note:
Pop-Ups are a setting on your PC. Please liaise with your IT contact if required.

9.1 Google Chrome

9.1.1 Allow all pop-ups
You can allow all pop-ups by turning off Chrome’s pop-up blocker. Here’s how:

1. **Computer:**
   1. In the top-right corner of the browser window, click the Chrome menu .
   2. Select Settings.
   3. Click Show advanced settings.
   4. Under "Privacy," click the Content settings button.
   5. Under "Pop-ups," select Allow all sites to show pop-ups.

Using a Chrome device at work? Your network administrator might configure the pop-up blocker for you, in which case you can’t change this setting yourself.

2. **Mobile device:**
   1. Open the Chrome menu.
   2. Touch Settings.
   3. Touch Content Settings.
   4. Touch Block Pop-ups to turn all pop-ups ON.

9.1.2 Manage pop-ups for a specific site
To manually allow pop-ups from a site, follow the steps below:

1. At the end of the address bar, click the pop-up blocker icon .
2. Click the link for the pop-up window you’d like to see.
3. To always see pop-ups for the site, select "Always show pop-ups from [site]." The site will be added to the exceptions list, which you can manage in the Content Settings dialog.
To always allow pop-ups from a particular site, follow the steps below:

1. In the top-right corner of the browser window, click the Chrome menu.
2. Select Settings.
3. Click Show advanced settings.
4. Under "Privacy," click the Content settings button.

9.2 Internet Explorer

Pop-up Blocker limits or blocks pop-ups on sites that you visit. You can choose the level of blocking you prefer, turn on or off notifications when pop-ups are blocked, or create a list of sites that you don't want to block pop-ups on. Pop-up Blocker settings only apply to Internet Explorer for the desktop.

Turn Pop-up Blocker on or off

9.2.1 Internet Explorer 8.0 (Windows 7/Vista/XP)

When a website attempts to launch a new pop-up window, you may see dialog boxes alerting you of pop-up windows that have been blocked. Follow the instructions below to allow pop-up windows on a per-website basis.

1. Open Internet Explorer, then go to the web page that you want to allow pop-ups.
2. In Internet Explorer's Address field, highlight the entire web address of the current page, then right-click and choose the Copy command.
3. From the Tools menu, select Pop-up Blocker → Pop-up Blocker Settings. The Pop-up Blocker Settings dialog box opens.
4. Right-click in the Address of website to allow: field, then choose Paste.

Learning Note:

Pasting the web address of a page you wish to allow pop-ups is recommended, rather than typing the generic main web address. For example, you might visit www.example.com/requirepopup.html, but the page is actually hosted at popup.example.com/forms/popupform.html. In this example, you must allow popup.example.com, not www.example.com. Note also that entire websites must be allowed, not individual directories or pages, so in this example Internet Explorer will automatically add the top level popup.example.com to its Allowed sites.
For more information about pop-ups, see *Pop-up Blocker FAQ*, located at the bottom of the dialog box.

1. Click **Add**. The selected website is added to the list of Allowed sites.

2. Click **Close** to close the Pop-up Blocker Settings dialog box.

### 9.2.2 Internet Explorer 9.0 (Windows 7/Vista)

When a website attempts to launch a new pop-up window, you may see dialog boxes alerting you of pop-up windows that have been blocked. Follow the instructions below to allow pop-up windows on a per-website basis.

1. Open Internet Explorer, then go to the web page that you want to allow pop-ups.

2. In Internet Explorer's Address field, highlight the entire web address of the current page, then right-click and choose the **Copy** command.

3. From the Tools menu (the gear icon on the far right), select Internet options. The Internet Options dialog box opens.

4. Click on the Privacy tab.

5. Under Pop-up Blocker, click **Settings**. The Pop-up Blocker Settings dialog box opens.

6. Right-click in the **Address of website to allow:** field, then choose Paste.

**Learning Note:**

Pasting the web address of a page you wish to allow pop-ups is recommended, rather than typing the generic main web address. For example, you might visit [www.example.com/requirepopup.html](http://www.example.com/requirepopup.html), but the page is actually hosted at [popup.example.com/forms/popupform.html](http://popup.example.com/forms/popupform.html). In this example, you must allow popup.example.com, not [www.example.com](http://www.example.com). Note also that entire websites must be allowed, not individual directories or pages, so in this example Internet Explorer will automatically add the top level [popup.example.com](http://popup.example.com) to its Allowed sites.

For more information about pop-ups, see Learn more about Pop-up Blocker, located at the bottom of the dialog box.

1. Click **Add**. The selected website is added to the list of Allowed sites.

2. Click **Close** to close the Pop-up Blocker Settings dialog box and click the **OK** button to close the Internet Options dialog box.
9.3 Firefox .current (Windows/OS X)

1. Open Firefox, then go to the web page that you want to allow pop-ups.

2. In Firefox's URL window, highlight the entire web address of the current page, then choose the Copy command from the Edit menu.

3. Select Options... from the Tools menu (Windows) or Preferences... from the Firefox menu (OS X). The Options (Windows) or variable (OS X) dialog box opens.

4. In the top panel of the dialog box, click on the Content icon to display the Content dialog box.

5. In the Content dialog box, ensure the Block pop-up windows checkbox is selected, then click the adjacent Exceptions... button.

6. Right-click or control-click in the Address of web site: field, choose Paste from the dropdown menu, then click Allow. The selected webpage is added to the list of Allowed Sites.

**Learning Note:**
Pasting the web address of a page you wish to allow pop-ups is recommended, rather than typing the generic main web address. For example, you might visit www.example.com/requirepopup.html, but the page is actually hosted at popup.example.com/forms/popupform.html. In this example, you must allow popup.example.com, not www.example.com. Note also that entire websites must be allowed, not individual directories or pages, so in this example Internet Explorer will automatically add the top level popup.example.com to its Allowed sites.

7. Close any remaining dialog boxes.

**Caution Note:**
Even if you turn pop-up blocker on, Internet Explorer won't block pop-ups from sites that are in the Local intranet or Trusted sites security zones. If you want to block all pop-ups—including pop-ups on Local intranet or Trusted sites—you'll have to change the blocking level.

10 More4Apps

More4Apps can be used if you invoice the Research Councils for multiple invoices. The template can be found on the UK SBS website iSupplier.

**Learning Note:**
The columns under Processing Status are for UK SBS use only.

1. Enter the Purchase Order number in P.O. Number – Invoice Level field.
2. Enter your Supplier Number. This information can be found on iSupplier under the Admin responsibility.

3. Enter the Supplier Site. This information can be found on iSupplier under the Admin responsibility. This will be the postcode of the remittance address.

4. Enter your Invoice Number.

5. The Invoice Date must be entered.

6. A Description of what you are billing the Research Council for should be entered.

Caution Note:
The Invoice Total field is the total NET amount being billed against that one invoice.

7. Enter the Invoice Total.

8. Enter the Currency Code.

9. Under Invoice Distributions enter the Dist Description. This should match or be similar to the PO description.

10. Enter the NET value in the Amount field.
11. Enter the Tax code.
   - Standard
   - Exempt
   - Zero
   - Out of Scope

12. The Product Category should be Non Recoverable Charged Gross.

13. Enter the P.O. Line Number. This can be found on the PO originally provided to you.

14. Enter the Quantity Invoiced, for example if the invoice relates to 5 @ £50.00 then enter 5.
    If the PO has been raised in pounds and pence enter the NET value of 250.

15. The Unit Price field must be populated for all PO’s created with a unit price.

<table>
<thead>
<tr>
<th>INVOICE DISTRIBUTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Details</td>
</tr>
<tr>
<td>Dist Description</td>
</tr>
<tr>
<td>Test</td>
</tr>
</tbody>
</table>

**Action Note:**

If your invoice relates to multiple lines on one Purchase Order you must split these down by individual lines that correspond with the PO. This should be done under the Invoice Distribution section. Repeat steps 9 to 15.

<table>
<thead>
<tr>
<th>INVOICE DISTRIBUTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Details</td>
</tr>
<tr>
<td>Dist Description</td>
</tr>
<tr>
<td>Test</td>
</tr>
<tr>
<td>Test</td>
</tr>
</tbody>
</table>

16. Completed forms should be submitted to finance@uksbs.co.uk with More4Apps as the subject title. A PDF copy of each invoice should also be attached to the email.